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Introduction to WinConnect Server ES
Product Description
WinConnect Server ES is a software solution that enables a Windows 8/8.1 Enterprise or Windows
8/8.1 Professional (32-bit & 64-bit) or Windows Server 2012 (64-bit) or Windows Server 2012
Foundation (64-bit) or Windows Server 2012 Essentials (64-bit) or Windows Sever 2012 R2 (64-bit) or
Windows Server 2012 R2 Foundation (64-bit) Host computer to allow multiple Remote Desktop
Protocol (RDP) 4.0, 5.0, 5.1, 5.2, 6.x and 7.x-enabled devices (such as Terminals, Internet/Information
Appliances, Tablet PCs and PDAs) to connect to it to run Windows applications simultaneously and
independently. You can remotely connect to your computer from another office, from home, or while
traveling. This allows you to use the data, applications, and network resources that are on your office
computer, without physically being in your office.
A broadband Internet connection over digital subscriber line (DSL, ADSL) or Integrated Services
Digital Network (ISDN) connection improves performance, but it is not necessary because Remote
Desktop transfers only the minimal data (such as display data and keyboard data) to remotely control
your Host computer. Therefore, even low–bandwidth Internet connections or a wired or wireless
TCP/IP connection, local area network (LAN), wide area network (WAN), dial-up (Internet), virtual
private network (VPN) connection allow you to remotely connect to your office computer.
Users on the Thin Client devices may run the same or different applications simultaneously and
independently to create and edit documents, and to share peripherals, for example, CD-ROM, printers
and other hardware installed on the Host computer. All users can also surf the Internet and access
emails at the same time and even share network access with unique customized desktop and login.

System Requirements
WinConnect Server ES requires a Windows 8/8.1 Enterprise or Windows 8/8.1 Professional (32-bit &
64-bit) or Windows Server 2012 (64-bit) or Windows Server 2012 Foundation (64-bit) or Windows
Server 2012 Essentials (64-bit) or Windows Sever 2012 R2 (64-bit) or Windows Server 2012 R2
Foundation (64-bit) computer with Network/Internet connection.
Pentium processor 2.8GHz or faster is the minimum recommendation for 1 Host and 1 Remote
Desktop user. For better performance, multi-core processor is suggested. Equivalent AMD processors
are also supported.
For Windows 8/8.1 Enterprise or Windows 8/8.1 Professional (32-bit), the minimum memory
requirement for 3 Remote Desktop users is (3 x 256 Megabytes) + 1 Gigabytes of RAM.
For Windows 8/8.1 Enterprise, Windows 8/8.1 Professional or Windows Server 2012 (64-bit) or
Windows Server 2012 R2 (64-bit), the minimum memory requirement for 3 Remote Desktop users is (3
x 256 Megabytes) + 2 Gigabytes of RAM.
An additional memory of 256MB or more is required for each additional Remote Desktop user,
depending on the applications the user will be running.

Manufacturer’s Notice
The WinConnect Server ES allows multiple users to simultaneously and independently share the same
hardware and software installed on the Host computer. Some software is licensed for use on a single
computer while other software may be licensed for single or multiple users. It is the responsibility of the
WinConnect Server ES purchaser/user to read and comply with the licensing agreements of any
software that may be used on the RDP devices.
A separate Windows 8/8.1 license may be required for each RDP device connected to the Host
computer running Windows 8/8.1. It is the responsibility of the WinConnect Server ES purchaser/user
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to read and comply with the Windows 8/8.1 licensing agreement or contact Microsoft for clarification
regarding this licensing requirement.

Terminology
The Host is the computer where Windows 8/8.1 Enterprise or Windows 8/8.1 Professional (32-bit &
64-bit) or Windows Server 2012 (64-bit) or Windows Server 2012 R2 (64-bit) and WinConnect Server
ES software are installed.
The Client is the Remote Desktop Protocol (RDP) 4.0, 5.0, 5.1, 5.2, 6.x or 7.x-enabled device (such as
Terminal, Internet/Information Appliance, Tablet PC and PDA).

1.

WinConnect Server ES Installation

1.1.

Installing the WinConnect Server ES for Windows 8/8.1 (32-bit) System

Windows 8/8.1 native Remote Desktop must be working correctly before the WinConnect Server ES software
is installed. To verify if it works, you can use a remote client to connect to the Windows 8/8.1 native Remote
Desktop.
Make sure that you have also configured your Windows Firewall (or any Firewall) not to block TCP ports 3389
(0d3d Hex).
Installation is simple. By following these steps, a WinConnect Server ES system should take less than 10
minutes to set up. Each step is explained in detail in the following pages.

Step 1.
Download the WinConnect Server ES software from www.thinsoftinc.com. Once this file is
saved onto your hard disk, locate it and double-click on the filename, setup.exe.

Step 2.
Follow the instructions on the screen. Click “Next” to proceed.
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Step 3.
After reading and accepting the license agreement, click on the “Next” button to continue with the
WinConnect Server ES software installation.

Step 4.
You should see a window similar to the one below. Click on the “Next” button.
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Step 5.
To install the WinConnect Server ES software to the default folder, click “Next” to proceed.

Step 6.
Select the additional tasks you would like to perform while installing WinConnect Server ES. Click
“Next” to proceed.

7

Step 7.
Review the settings in the InstallShield Wizard. Click “Next” to proceed or “Back” to modify the
settings.

Step 8.
Once the InstallShield Wizard has successfully installed the WinConnect Server ES software, you will
be prompted to restart your computer. Click “Finish” to complete the setup.

Congratulations! You have fully installed the WinConnect Server ES software. You are now ready to install the
Remote Desktop Client for Linux or Windows System.
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1.2. Installing the WinConnect Server ES Software for Windows 8/8.1 or
Windows Server 2012 (64-bit) or Windows Server 2012 R2 (64-bit) System
Windows 8/8.1 native Remote Desktop or Windows Server 2012 or Windows Server 2012 R2 native terminal
services must be working correctly before the WinConnect Server ES software is installed. To verify if it works,
you can use a remote client to connect to the Windows 8/8.1 native Remote Desktop or Windows Server 2012
or Windows Server 2012 R2 native terminal services.
Make sure that you have also configured your Windows Firewall (or any Firewall) not to block TCP ports 3389
(0d3d Hex).
Installation is simple. By following these steps, a WinConnect Server ES system should take less than 10
minutes to set up. Each step is explained in detail in the following pages.

Step 1.
Download the WinConnect Server ES software from www.thinsoftinc.com. Once this file is
saved onto your hard disk, locate it and double-click on the filename, setup.exe.

Step 2.
Follow the instructions on the screen. Click “Next” to proceed.

Step 3.
After reading and accepting the license agreement, click on the “Next” button to continue with the
WinConnect Server ES software installation.
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Step 4.
You should see a window similar to the one below. Click on the “Next” button.

Step 5.
To install the WinConnect Server ES software to the default folder, click “Next” to proceed.
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Step 6.
Select the additional tasks you would like to perform while installing WinConnect Server ES. Click
“Next” to proceed.

Step 7.
Review the settings in the InstallShield Wizard. Click “Next” to proceed or “Back” to modify the
settings.
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Step 8.
Once the InstallShield Wizard has successfully installed the WinConnect Server ES software, you will
be prompted to restart your computer. Click “Finish” to complete the setup.

Congratulations! You have fully installed the WinConnect Server ES software. You are now ready to install the
Remote Desktop Client for Linux or Windows System.

1.3.

Using the WinConnect Server ES Control Center

The WinConnect Server ES Control Center can be used to view the Remote Desktop connections, as well as
the processes and applications that are running on each Remote Desktop session. It allows you to send
messages to the Remote Desktop users, logoff or disconnect the Remote Desktop sessions on the
WinConnect Server ES Host.
To view the Remote Desktop Client connections, click on the “+” sign next to the WinConnect Server ES
Host computer name.
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Note: User must start the WinConnect Server ES Control Center using "Run as administrator" to
change settings in the WinConnect Server ES Control Center. To enable the Administrator
privilege, right-click on the WinConnect Server ES Control Center and select “Run as
administrator”.

There are nine icons in the toolbar of the Control Center – Refresh, Connect Session, Disconnect Session, Logoff
Session, Send Message, Properties, About, Online Help and Activity Log.

1.3.1.

Refresh

Refresh is selected by clicking on the “Refresh” icon.

The Remote Desktop connections displayed are periodically refreshed to update any connection status changes.
If you do not wish to wait for the periodic refresh to update any connection status changes, you can click on
the “Refresh” button for an immediate update.
1.3.2.

Connect Session

Connect session is selected by clicking on the “Connect session” icon.

To connect to a Disconnected Remote Desktop session on the WinConnect Server ES Host, you can rightclick on the Disconnected Remote Desktop session “RDP-Tcp#1(XXX)” where XXX is the user login name
and select “Connect”.
1.3.3.

Disconnect Session

Disconnect session is selected by clicking on the “Disconnect session” icon.

To disconnect an active Remote Desktop session on the WinConnect Server ES Host. You can right-click on
the active Remote Desktop session “RDP-Tcp#1(XXX)” where XXX is the user login name and select
“Disconnect”.
Disconnect leaves the Remote Desktop session, including any applications running within the Remote Desktop
session, active on the Terminal Server even though the Remote Desktop Client is not actually controlling it. As
a result, the Remote Desktop session still consumes resources on the Terminal Server. When the same user
login into the Terminal Server at a later time, the user reconnects to the disconnected Remote Desktop session.
This feature is useful if the user wishes to run a time consuming operation, such as a report generation or
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database query, disconnects from the Remote Desktop session and login into the Terminal Server at a later
time, reconnects to the disconnected Remote Desktop session, to view the results or resume the task.
Note: Only a user with administrative rights can disconnect an active Remote Desktop session.
1.3.4.

Logoff Session

Logoff session is selected by clicking on the “Logoff session” icon.

To logoff a Remote Desktop session on the WinConnect Server ES Host. Alternatively, you can right-click on
the Remote Desktop session “RDP-Tcp#1(XXX)” where XXX is the user login name and select “Logoff”.
Logoff ends the Remote Desktop session running on the Terminal Server; terminating any applications running
within the Remote Desktop session and all changes not saved will be lost. When the user login into the
Terminal Server the next time, a new Remote Desktop session is created. In general, it is preferable to logoff a
Remote Desktop session rather than disconnect a Remote Desktop session.
Note: Only a user with administrative rights can logoff a Remote Desktop session.
1.3.5.

Send Message

Send message is selected by clicking on the “Send message ” icon.

To send a message to a Remote Desktop user. Alternatively, you can right-click on the Remote Desktop
session “RDP-Tcp#1(XXX)” where XXX is the user login name and select “Send message”.

1.3.6.

Properties

Properties is selected by clicking on the “Properties” icon.
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To view or change the Server and RDP settings. Alternatively, you can right-click on the WinConnect Server
ES Host computer name (e.g. I965) and select “Properties”. Double-click on the respective feature to change
the setting.
1.3.7.

About

About is selected by clicking on the “About” icon.

About the version of WinConnect Server ES software.
1.3.8.

Online Help

Online Help is selected by clicking on the “Online Help” icon.

Clicking on this button, it will invoke your web browser and link you to the ThinSoft Technical Support’s web
site.
1.3.9.

Activity Log

Activity Log is selected by clicking on the “Activity Log” icon.

Display remote desktop clients’ login and logout activity.
1.3.10.

Menu Options

Additional options are available from the menu bar at the top of the WinConnect Server ES Control Center.

1.3.10.1 File Menu
The File menu allows users to close the Control Center application.

To exit, select File/Exit on the Control Center’s main menu bar.
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1.3.10.2 View Menu
The View menu allows users to view the Remote Desktop Client connections, as well as the processes and
applications that are running on the Remote Desktop Clients.

 Toolbar – displays the seven icons in the toolbar of the Control Center – Refresh, Disconnect
Session, Logoff Session, Send Message, Properties, About and Online Help.

 Status Bar – displays the event status at the bottom of the Control Center.
 Refresh - displays the changes in the Remote Desktop Client connection status.
1.3.10.3 Actions Menu
The Actions menu allows users to view or change the Server and RDP settings, remote control or shadow to
or from a Remote Desktop session and send messages to the Remote Desktop users on the Remote Desktop
Clients. Users can logoff or disconnect the Remote Desktop Clients and connect a disconnected Remote
Desktop session on the WinConnect Server ES Host.



Connect – connects a disconnected Remote Desktop session on the WinConnect Server ES Host.
To connect, click on the “Connect session” icon in the toolbar of the Control Center; or select
Actions/Connect on the Control Center’s main menu bar.



Disconnect – disconnects an active Remote Desktop session on the WinConnect Server ES Host.
To disconnect, click on the “Disconnect session” icon in the toolbar of the Control Center; or select
Actions/Disconnect on the Control Center’s main menu bar.
Note: Only a user with administrative rights can disconnect an active Remote Desktop session.

 Logoff – logoff a Remote Desktop session on the WinConnect Server ES Host. To logoff, click on
the “Logoff session” icon in the toolbar of the Control Center; or select Actions/Logoff on the
Control Center’s main menu bar.
Note: Only a user with administrative rights can log off a Remote Desktop session.
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 Send Message - sends a message to the users on the Remote Desktop Clients by clicking on the
“Send Message” icon in the toolbar of the Control Center; or select Actions/Send Message on the
Control Center’s main menu bar.


User Settings – to change a user’s settings; please refer to User Settings section below for details.

 Properties - views or changes the Server and RDP settings in the Control Center by clicking on the
“Properties” icon in the toolbar of the Control Center; or select Actions/Properties on the Control
Center’s main menu bar.
1.3.10.4 Options Menu
The Options menu allows users to select different languages for the WinConnect Server ES Control Center if
desired and to edit the user settings.



Set Language – sets different languages for the WinConnect Server ES Control Center.



User Settings – to view or change a user's settings.


To change a local user's settings (i.e. a local user on the local machine where WinConnect Server
ES is installed), you will need to first login as a Local Administrator.



To change a domain user's settings, (i.e. a domain user on a Domain Controller), you will need to
first login as a Domain Controller Administrator.
Note: To change a domain user's settings, it is strongly recommended that the changes be made
on the Domain Controller itself. Please refer to the Domain Controller Administrator for any
changes.



To change a user's settings, enter the Username, the Server name where the Username was
created and click "OK". The Server name, Username and the user's current settings will be
displayed.
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Allow RDP Logon – to enable or disable the user to be allowed to login into the Terminal
Server using Remote Desktop connection. Default is "Yes", i.e. user is allowed to login into the
Terminal Server using Remote Desktop connection.



Use Initial Program from Client – determines if the user's settings (i.e. Initial Program and
Working Directory settings) or the Remote Desktop Client's Remote Desktop connection
software’s settings will be used to specify the initial program to be run at logon. Default is “Yes”,
i.e. Remote Desktop Client's Remote Desktop connection software’s settings will be used to
specify the initial program to be run at logon.



Initial Program – specifies the path of the initial program to be run at logon if the Use Initial
Program from Client setting is set to "No". When the program is terminated, the user will be
logged off from the Terminal Server. Default is “None”. To indicate the path of the working
directory used by the initial program, please refer to the “Working Directory” setting.



Working Directory – specifies the path of the working directory used by the initial program if
the Use Initial Program from Client option is set to "No". Default is “None”.



Max Session Connection Time - specifies the maximum time limit a Remote Desktop session
can stay connected before the server automatically disconnects the Remote Desktop session.
Default is “Never”.



Max Session Disconnection Time - specifies the maximum time limit a Remote Desktop
session can stay disconnected before the Terminal Server automatically logs off or terminates the
disconnected Remote Desktop session. Default is “Never”.



Max Session Idle Time - specifies the maximum time limit a Remote Desktop session can
remain idle (i.e. no keyboard or mouse activity) before the Terminal Server automatically
disconnects the Remote Desktop session. Default is “Never”.



On Timeout or Disconnect – instructs the Terminal Server what to do when a Remote
Desktop session reaches its session limit or timeout, or if a Remote Desktop session becomes
accidentally disconnected (broken connection). The Terminal Server can disconnect or terminate
the Remote Desktop session. Default is “Disconnect Session”.
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Allow Reconnection – specifies the Reconnect setting to allow the user to reconnect to a
disconnected Remote Desktop session from any computer or only allow the user to reconnect to
a disconnected Remote Desktop session from same the computer that originally started the
Remote Desktop session. The default is to allow reconnection “From any client”.

To look at the processes and applications that are running on the Remote Desktop Clients, click on the client
connection “RDP-Tcp#0(XXX)” where XXX is the user login name.

1.4.

Settings:
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1.4.1. Server Settings:


Remote Desktop - enables or disables the ability for Remote Desktop Clients to connect to the
WinConnect Server ES Host using Remote Desktop connection. Default is “Enabled”.



Remote Assistance - enables or disables the ability to send invitation for Remote Assistance. Default
is “Enabled”.



WinConnect Server RDP - enables or disables WinConnect Server ES Host Remote Desktop
support. Changing this setting requires a system reboot. Default is “Enabled”.



Advertise Terminal Services - determines if the Terminal Server advertises itself as a Terminal
Server on the local network. When enabled, it allows Remote Desktop Clients to locate the available
Terminal Servers on the local network. Default is “Yes”.



Restrict Computer Shutdown Privileges – allows any user to shutdown the system or restrict the
shutdown option to users with Administrator privileges. Restricting shutdown to Administrator
requires an Administrator to login to shutdown the system. Domain security policies may override
this setting. Default is “Any user”.



Hide WCS System Tray Icon – shows or hides the Remote Desktop session icon. The icon
provides access to Windows Task Manager and Disconnect option. Default is “No”.

1.4.2. RemoteApp:


Restrict RemoteApp Program Use – restricts RDP clients "Initial Programs" to those specified in
the list. If set to "No", WinConnect Server will allow the remote clients to run any initial program
upon remote connection. If set to "Yes", WinConnect Server will only allow the remote clients to run
the initial program as specified in the list upon remote connection. Default setting is "No".

1.4.3. RDP Settings:


Max Displayable Colors - limits the maximum number of colors supported under the Remote
Desktop session. More colors mean more network bandwidth is required for data transfer. Fewer
colors reduce the network bandwidth required and improve the overall performance. Default is “32bit colors”.
Note: 16-bit or 24-bit color is currently not supported in Windows 8/8.1 (32-bit & 64-bit) and
Windows Server 2012 (64-bit) or Windows Server 2012 R2 (64-bit). Should you have any query, please
contact Microsoft for more information.



Max Session Connection Time - specifies the Terminal Server's maximum time limit a Remote
Desktop session can stay connected before the Terminal Server automatically disconnects or
terminates the Remote Desktop session. Default is “Never”.
Note:



The “Override user settings?” option needs to be checked in order for the Terminal Server's
setting to take effect.

Max Session Disconnection Time - specifies the Terminal Server's maximum time limit a Remote
Desktop session can stay disconnected before the Terminal Server automatically logs off or
terminates the disconnected Remote Desktop session. Default is “Never”.
Note:

The “Override user settings?” option needs to be checked in order for the Terminal Server's
setting to take effect.
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Max Session Idle Time - specifies the Terminal Server's maximum time limit a Remote Desktop
session can remain idle (i.e. no keyboard or mouse activity) before the Terminal Server automatically
disconnects the Remote Desktop session. Default is “Never”.
Note:



The “Override user settings?” option needs to be checked in order for the Terminal Server's
setting to take effect.

On Timeout or Disconnect – specify the action the Terminal Server needs to do when a Remote
Desktop session reaches its session limit or timeout, or if a Remote Desktop session becomes
accidentally disconnected (broken connection). The Terminal Server can disconnect or terminate the
Remote Desktop session. Default is “Disconnect Session”.
Note:

The “Override user settings?” option needs to be checked in order for the Terminal Server's
setting to take effect.



Min Encryption Level - specifies the minimum encryption level required for a Remote Desktop
Client to connect to the Terminal Server: High, Medium or Low. Default is “Medium”.



Always Prompt for Password – asks for a logon password when the Remote Desktop Client
connects to the Terminal Server and ignore any logon password sent by the Remote Desktop Client.
Default is “No”.



Limit Blank Password Use – limits local account use of blank passwords to console logon only. If
set to “Yes”, Remote Desktop User (apply to local user account only, i.e. Non-Domain user account)
will need to a password to logon into Windows. Default is “Yes”.



Single Session Per User – restrict a user to a single Remote Desktop session. When enabled, the
active Remote Desktop session will be disconnected when the same user login on another Remote
Desktop session. When disabled, the same user can login on multiple Remote Desktop sessions.
Default is “Yes.



Only login RemoteDesktopUsers Group – If “No” (the default), all members of the Users group
are automatically added to the RemoteDesktopUsers group and all users can log into the Terminal
Server. If “Yes”, only members in the Administrators and RemoteDesktopUsers groups can log into
the Terminal Server. After setting to Yes, manually remove any users from the RemoteDesktopUsers
group who are not allowed to log into the Terminal Server.
To edit the Remote Desktop Users group, right click on My Computer, select Remote and click on
"Select Remote Users…" to add or remove Remote Desktop users.



Require Network Level Authentication - If “Yes”, requires user authentication using Network
Level authentication before the RDP session is connected. Default is “No”.

1.4.4. Reconnect Settings:


Use Reconnection Settings from User – specifies if the Reconnect setting is set to use the each
individual user’s setting or the Terminal Server’s Reconnect setting. Default is “Yes” (i.e. use the
individual user's setting).
To change a user's Reconnect setting, please refer to User Settings section below for details.



Allow Reconnection – specifies the Terminal Server's Reconnect setting to allow a user to reconnect
to a disconnected Remote Desktop session from any computer or only allow a user to reconnect to a
disconnected Remote Desktop session from same the computer that originally started the Remote
Desktop session. The default Terminal Server's Reconnect setting is to allow reconnection “From any
client”, this is a global setting for all users.
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1.4.5. Client Features:


Enable Audio Mapping – enables or disables the Terminal Server to allow the Remote Desktop
session's audio to be re-directed to the Remote Desktop Client. When enabled, this allows audio
generated by an application running within the Remote Desktop session to be playback on the
Remote Desktop Client. Default is “Enabled”.



Enable Drive Mapping – enables or disables the Terminal Server to allow the Remote Desktop
Client’s local drives to be mapped to the Remote Desktop session. When enabled, this allows an
application running within the Remote Desktop session to access the local drives on the Remote
Desktop Client. Default is “Enabled”.



Enable COM Port Mapping – enables or disables the Terminal Server to allow the Remote
Desktop Client’s local COM ports to be re-directed to the Remote Desktop session. When enabled,
this allows an application running within the Remote Desktop session to access the COM ports on
the Remote Desktop Client. Default is “Enabled”.



Enable LPT Port Mapping – enables or disables the Terminal Server to allow the Remote Desktop
Client’s local LPT ports to be re-directed to the Remote Desktop session. When enabled, this allows
an application running within the Remote Desktop session to access the LPT ports on the Remote
Desktop Client. Default is “Enabled”.



Enable Windows Printer Mapping – enables or disables the Terminal Server to allow the Remote
Desktop Client’s local printers to be re-directed to the Remote Desktop session. When enabled, this
allows an application running within the Remote Desktop session to print to the local printer
connected to the LPT port of the Remote Desktop Client. Default is “Enabled”.



Enable Clipboard – enable or disable the Terminal Server to allow the Remote Desktop Client’s
Clipboard to be shared from within the Remote Desktop session. When enabled, this allows copying
and pasting of data between applications running within the Remote Desktop session and applications
running on the Remote Desktop Client. Default is “Enabled”.

Note:

1.5.

The Remote Desktop Client's Remote Desktop Connection software's (i.e. the software used by
the Remote Desktop Client to connect to the Terminal Server) equivalent features must be
enabled as well, in order for any of the above features to work correctly (i.e. the feature must be
enabled on both the Terminal Server and Remote Desktop Client).

Registration/Licensing

1.5.1. Demo version
When initially installed, WinConnect Server ES runs in “demo mode”. While in demo mode, you can evaluate
WinConnect Server ES before you purchase. During the evaluation period, the software enables you to connect
up to 6 Remote Desktop Clients. After the period, the Remote Desktop Clients will be automatically logoff
from the WinConnect Server ES system.
If you do wish to purchase WinConnect Server ES, you will need to access our web site to purchase and
register the software.
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1.5.2. Purchase/Internet Registration
Note:

(i) You must purchase/register WinConnect Server ES from the computer on which it has been
installed (i.e. NOT from any other computer). Hence, please ensure that you have installed
WinConnect Server ES software on the computer where you intend to deploy it and make sure
WinConnect Server ES is working correctly in demo mode and meeting your requirement before
proceeding with the purchase/registration process.
(ii) Ensure that you are using the Microsoft's Internet Explorer (32-bit) as the default browser.
(iii) Make sure you have logged into the Windows 8/8.1 (32-bit or 64-bit) or Windows Server 2012
(64-bit) or Windows Server 2012 R2 (64-bit), as an Administrator with full access rights.
(iv) For the purchase or registration process to work correctly, you will need to run Microsoft's
Internet Explorer (32-bit) with Administrator privileges. If you are not running Microsoft's Internet
Explorer (32-bit) with Administrator privileges, please close Microsoft's Internet Explorer (32-bit) and
follow the instructions described below to run Microsoft's Internet Explorer (32-bit) in Administrator
privileges:
To run Internet Explorer with Administrator privileges, on the "Start" screen, click on the
"Desktop" icon. On the "Desktop" screen, locate the Internet Explorer icon on the Taskbar.
Right-click on the Internet Explorer icon, move the mouse pointer to "Internet Explorer"
and then right-click on "Internet Explorer" and click on "Run as administrator".

A "User Account Control" prompt will appear, you will need to click on the "Yes" button to run
Internet Explorer with Administrator privileges.
(v) The "Internet Explorer Enhanced Security Configuration" setting in Windows Server 2012 or
Windows Server 2012 R2 must be turned off. Locate the Server Manager icon on the Taskbar. Click
on the Server Manager icon -> Local Server. Under the Properties section, locate "IE Enhanced
Security Configuration” and then select "Off" for the Administrator.
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(vi) Within Internet Explorer, click on Tools -> Internet Options -> Security. Set the "Security level
for this zone” to "Medium" and click on the "OK" button to apply the changes. This is what the
WinConnect Server Registration site requires in order to successfully complete the purchase &
registration process.

Notes: When prompted to install and run the "ThinSoft ..." and/or the "SheriffNet Module" ActiveX
controls, you must click on the "Yes" button to install and run the ActiveX controls.
Please wait for each page to load completely before proceeding to the next page.

Step 1.
On the Windows desktop, right click on the WinConnect Server ES Control Center and then click
“Run as administrator”.
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Step 2.
Select Help from the WinConnect Server ES Control Center menu bar and then select “Register on
the Web”.

Step 3.
Microsoft Internet Explorer will be launched and directed to the WinConnect Server ES Registration
site. Select the language you wish to use to register WinConnect Server ES.
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Step 4.
If you have purchased WinConnect Server ES prepaid serial number(s), enter the prepaid serial
number(s) and click the “Register New Serial Numbers” button. If you do not have WinConnect
Server ES prepaid serial number(s) and want to purchase/ register WinConnect Server ES license
online, click “CREATE NEW LICENSE AND PURCHASE WinConnect Server” button.

Step 5.
Enter the information requested and click “CONTINUE WITH REGISTRATION”.
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Step 6.
Once WinConnect Server ES is successfully registered, you will need to restart Windows.

2.

Microsoft Windows Remote Desktop Client Setup

2.1.

Connect to WinConnect Server ES Host using Remote Desktop Connection

The Microsoft Remote Desktop Connection client software allows Windows platforms to remotely connect to
a WinConnect Server ES Host to run Windows applications.
The Remote Desktop Connection client software is installed by default on Windows XP, Windows Vista,
Windows 7, Windows 8/8.1, Windows Server 2008, Windows Server 2008 R2, Windows Server 2008 R2
Foundation, Windows Small Business Server 2008/2011, Windows Server 2012 or Windows Server 2012 R2.
For a client computer that is running Windows 95, Windows 98, Windows Me, Windows NT 4.0, or Windows
2000, you need to install Remote Desktop Connection client software from Microsoft Download Center
(http://www.microsoft.com/downloads). Simply go to the web site and search for “Remote Desktop
Connection software.”

27

2.2.

Connect a work PC to WinConnect Server ES Host
Step 1.
Open Remote Desktop Connection. (i.e. on a Windows XP computer, click Start, point to Programs,
point to Accessories, and then click Remote Desktop Connection.)

Step 2.
Enter the IP address of the WinConnect Server ES Host that you want to connect to, and then click
Connect. (You can also enter the PC name instead of IP address)

2.3.

Connect a home PC to WinConnect Server ES Host

To connect to a WinConnect Server ES Host from a home PC, you need to connect to the corporate network.
You can do in this way (if you're not sure, talk to your system administrator):
Virtual Private Network (VPN) connect PCs to large networks (usually corporate) over the Internet.
Ask your network administrator for the name of the VPN server before you open the wizard.

Step 1.
Open Network Connections. (i.e. on a Windows XP computer, click Start => Control Panel =>
Network and Sharing Center. Under Tasks, click on “Create a connection to the network at your
workplace)
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Step 2.
Click “Virtual Private Network connection” (VPN), click Next, and then follow the instructions in the
wizard.
Notes: If you have an active Winsock Proxy client, you cannot create a VPN. A Winsock Proxy client
immediately redirects data to a configured proxy server before the data can be processed in the
fashion required by a VPN. To establish a VPN, you should disable the Winsock Proxy client.

Step 3.
Open Remote Desktop Connection. (i.e. on a Windows XP computer, click Start, point to Programs,
point to Accessories, and then click Remote Desktop Connection.)

Step 4.
Enter the IP address of the WinConnect Server ES Host that you want to connect to, and then click
Connect. (You can also enter the PC name instead of IP address.)
If you need any technical assistance or more information on the Microsoft Remote Desktop Client Software,
please refer to Microsoft web site at http://www.microsoft.com.

2.4.

Local Printer Re-direction

I. For local printer re-direction on the remote client (i.e. printing to the local printer connected physically to the
remote client), follow the instructions below:
1. On the remote client, before connecting to the WinConnect Server ES system, you will need to install the
printer as per normal and make sure that the printer is working correctly, please refer to the printer user manual
for installation instructions.
2. On the remote client, open the MS Remote Desktop Connection software, click on Options --> Local
Resources, and check "Printers". Then connect to WinConnect Server ES system.
On the remote desktop session, click on Start --> Settings --> Printers, you should then see your printer.
NOTES:
Printing at the remote client location is a function of the MS Remote Desktop Connection software being used.
The MS Remote Desktop Connection software send the information about the local printer to WinConnect
Server ES/Windows Vista/Windows 7/Windows 8/Windows 8.1/Windows Small Business Server
2008/Windows Small Business Server 2011/Windows Server 2008/Windows Server 2008 R2/Windows Server
2008 R2 Foundation/Windows Server 2012/Windows Server 2012 Foundation/Windows Server 2012
Essentials/Windows Sever 2012 R2/Windows Server 2012 R2 Foundation system and if that printer is listed
among the Windows native printer list, then all will go fine. If the printer model is not one contained within the
list of Windows native printers, then it will be necessary to install the printer driver on the WinConnect Server
ES/Windows Vista/Windows 7/Windows 8/Windows Small Business Server 2008/Windows Small Business
Server 2011/Windows Server 2008/Windows Server 2008 R2/Windows Server 2008 R2 Foundation/Windows
Server 2012/Windows Server 2012 Foundation/Windows Server 2012 Essentials/Windows Sever 2012
R2/Windows Server 2012 R2 Foundation system first. In some cases, to install the printer correctly on the
WinConnect Server ES/ Windows Vista/Windows Small Business Server 2008/Windows Small Business
Server 2011/Windows Server 2008/Windows Server 2008 R2/Windows Server 2008 R2 Foundation/Windows
Server 2012/Windows Server 2012 Foundation/Windows Server 2012 Essentials/Windows Sever 2012
R2/Windows Server 2012 R2 Foundation system will require actually connecting the printer to the
WinConnect Server ES/ Windows Vista/Windows 7/Windows 8/Windows Small Business Server
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2008/Windows Small Business Server 2011/Windows Server 2008/Windows Server 2008 R2/Windows Server
2008 R2 Foundation/Windows Server 2012/Windows Server 2012 Foundation/Windows Server 2012
Essentials/Windows Sever 2012 R2/Windows Server 2012 R2 Foundation system or the printer driver will not
install properly. When this installation is done, the printer should be detected as a local printer when the remote
client is connected to the WinConnect Server ES/ Windows Vista/Windows 7/Windows 8/Windows Small
Business Server 2008/Windows Small Business Server 2011/Windows Server 2008/Windows Server 2008
R2/Windows Server 2008 R2 Foundation/Windows Server 2012/Windows Server 2012 Foundation/Windows
Server 2012 Essentials/Windows Sever 2012 R2/Windows Server 2012 R2 Foundation.
If local printing still does not work after following the above procedure, you will need to check with the printer
manufacturer to verify if the printer driver is designed to support Windows Terminal Services, or the procedure
to install the printer and it's printer driver to work under Windows Terminal Services
Printers that use ports that do not begin with COM, LPT, or USB are not redirected in a remote desktop
connection. Please check with your printer manufacturer's Technical Support on how to configure your printer
to use a COM/LPT/USB port.
II. For local printer redirection for local printer using DOT port or network printer, refer to the following MS
article (Note: the local printer driver must be installed on the Host):
http://support.microsoft.com/kb/302361
Printers That Use Ports That Do Not Begin With COM, LPT, or USB Are Not Redirected in a Remote
Desktop or Terminal Services Session
View products that this article applies to.
Article ID : 302361
Last Review : December 3, 2007
Revision : 4.8
This article was previously published under Q302361
SYMPTOMS
When you use Remote Desktop Connection or the Terminal Services Client version 4.0 or 5.0 to connect to
another Windows-based computer from a computer that is not running Windows Server 2003, your local
printers may not be redirected. As a result, your local printers are not available in the remote desktop or
terminal services session.
For example, if your Windows XP-based computer has a multifunction print device using a DOT4 port, it may
not be redirected in a remote desktop session to a Windows 2000- or Windows Server 2003-based computer.
CAUSE
This problem occurs because the printer port does not begin with COM, LPT, or USB. By default, printer port
names that do not begin with COM, LPT, or USB are only redirected in Windows Server 2003. By default,
multifunction print devices may not be redirected unless you are running Windows Server 2003 on your local
computer because they use DOT4 ports.
RESOLUTION
To resolve this problem on a computer that is not running Windows Server 2003, force all ports (including
DOT4) on the client computer to be filtered for redirection. To do this, add a DWORD value named
FilterQueueType to HKEY_CURRENT_USER\Software\Microsoft\Terminal Server
Client\Default\AddIns\RDPDR and set its value data to FFFFFFFF.
Follow these steps, and then quit Registry Editor:
1. Click Start, click Run, type regedit, and then click OK.
2. Locate and then click the following key in the registry:
HKEY_CURRENT_USER\Software\Microsoft\Terminal Server Client\Default\AddIns\RDPDR
3. On the Edit menu, point to New, and then click DWORD Value.
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4. Type FilterQueueType, and then press ENTER.
5. On the Edit menu, click Modify.
6. Type FFFFFFFF, and then click OK.
This enables all ports on the client to be redirected.
To work around this problem on a client computer that has a multifunction print device, change the port that
the multifunction print device uses from DOT4 to an LPT port.
For example, to configure a multifunction print device to use an LPT port on a Windows XP-based computer,
follow these steps:
1. In Control Panel, open Printers and Faxes.
2. Right-click the local printer that is not redirected, and then click Properties.
3. Click the Ports tab, click an LPT port, and then click Apply.
The printer should now appear next to that port.
4. Close the Printer Properties window, and then reconnect by using Remote Desktop.
Important When a multifunction printer is using a standard LPT port instead of the DOT4 port, it loses its
multifunction capabilities, such as scanning, faxing, or copying. To regain the multifunction capabilities, the
print device must use the DOT4 port.
STATUS
This behavior is by design.
MORE INFORMATION
To view the port name for your printer, or to determine if the device uses a DOT4 port, view the properties of
that printer, and then click the Ports(or the Details) tab.

2.5. Connecting to Console Session of Windows 8/8.1 (32-bit & 64-bit) or
Windows Server 2012 (64-bit) or Windows Server 2012 R2
Follow the steps described below to connect to the WinConnect Server ES system's Console session from the
remote client via the Remote Desktop Connection software:

Step 1.
Open Remote Desktop Connection. (i.e. on a Windows XP computer, click Start, point to Programs,
point to Accessories, and then click Remote Desktop Connection.)

Step 2.
Enter the IP address of the WinConnect Server ES Host that you want to connect to, and then click
Connect. (You can also enter the PC name instead of IP address)
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Step 3.
In the Log On to Windows dialog box, type in the same user name and password that user has logged
on the WinConnect Server ES system, and then press the Enter key. The Remote Desktop window
will open.

3.

Configuring Router's Port Forwarding For Remote
Desktop Access

The Remote Desktop Client software allows Windows platforms to remotely connect to a WinConnect Server
ES Host to run Windows applications.
First, get the IP address of the host computer (the computer that will have WinConnect Server ES installed on
it).
Click Start then Run and enter the letters CMD.
In the DOS box that appears, enter the command: ipconfig. Then hit the Enter key.
The computer’s IP address will be displayed in the information shown. Make note of it.
Next, open a browser and enter the URL http://www.portforward.com in the address bar.
At the bottom of PortForward’s opening page, make a note of the IP address shown after the text: Your
external IP address is
This IP address is what your remote users will need to enter into the “Computer” field in the Microsoft
Remote Desktop Connection program on their computers. Remote Desktop Connection is part of Windows
Vista, Windows 7, Windows 8/8.1, Windows Server 2008 (32-bit & 64-bit), Windows Server 2012, Windows
Server 2012 R2, Windows Server 2008 R2/R2 Foundation and Windows Small Business Server 2008/2011 (64bit) and can be found on the Accessories menu (Start/Programs/Accessories).
In the second paragraph on the PortForward opening page, locate the word Routers and click on it. This will
take you to a page displaying most brands and models of routers. Locate the specific brand and model of router
used in your location and click on it (if your router is not listed, please contact your router's vendor for details
on how to configure your router's port forwarding for Remote Desktop access).
This action takes you to the Application page. Scroll down until you locate Remote Desktop and click on it.
You will now see a step-by-step set of instructions for configuring your router to allow Remote Desktop
access. You will be asked to enter an IP address at the beginning of the configuration routine; this is the IP
address you obtained in the first part of these instructions.
Note:
Static IP address:
There are two IP addresses involved regarding Remote Desktop access. One is the external IP address owned
by the router and the other is the internal IP address of the host computer. Ideally, both of these should be
“static” (meaning they never change). Unfortunately, this is not always the case.
The external IP address is controlled by your Internet provider. You may check with them if you are not sure
whether your account has a static IP address.
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The host computer’s IP address is entirely in your control. For detailed information on how to set your host
computer to employ a static IP address, please see this web page,
http://www.portforward.com/networking/static-xp.htm

4.

Technical Support

Technical support offered by ThinSoft Pte Ltd
WinConnect products must be registered with ThinSoft before technical support may be offered.
Registration may be completed by registering online at our World Wide Web site. Free support via fax and
email is offered for sixty (60) days from the date of registration. Our technical staff is available to answer
questions, troubleshoot problems and to assist in the installation of WinConnect products. Before requesting
technical support, please be prepared to provide information including the date and place of purchase and
product serial number (______________________).
http://www.thinsoftinc.com
ThinSoft Pte Ltd
23 Tai Seng Drive
#06-00
Singapore 535224
Fax: (65)-6289-7308
email: support@thinsoftinc.com
Support hours are 9:00 to 5:00 local time.
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